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Interaction Network and
ReactomeFIViz app

— —

Contact: help@reactome.org
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Learning Objectives of Module

°* Be able to perform pathway and network-based data analysis
using ReactomeFIViz app
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Reactome Functional Interaction (FI) Network and
ReactomeFIViz app

* No single mutated gene is necessary and e /
sufficient to cause cancer. "

* Typically one or two common mutations (e.g.
TP53) plus rare mutations.

* Analyzing mutated genes in a network context:

* reveals relationships among these genes.

- §3

* can elucidate mechanism of action of drivers.

s
& . . >
- .
S gl .
.

* facilitates hypothesis generation on roles of
these genes in disease phenotype. =

.
M

* Network analysis reduces hundreds of mutated
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What is a Functional Interaction?

* Convert reactions in pathways into pair-wise relationships

* Functional Interaction:an interaction in which two proteins are
involved in the same reaction as input, catalyst, activator and/or inhibitor,
or as components in a complex

Reaction Functional Interactions
Input|-Input2, Input|-Catalyst,
\ Inputl I Input2 InPUtI -ACtivatOl', |nput | -

’ ) Inhibitor, Input2-Catalyst, Input2-

mplex y INP yst, Inp

o2 / \ Activator, Input2-Inhibtior,
Catalyst-Activator, Catalyst-

g Co
Inhibitor, Activator-Inhibitor

functional protein interaction network and its application
ome Biology. .
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Construction of the FI Network

| Reactome |
KEGG ]

| Panther Pathways |
[ NCI-Nature ]
~ NCI-BioCarta )
[ ]
[ ]

R

Encode TF/Target
TRED TF/Target

Data sources for predicted Fls

Data sources for annotated Fls

Featured by Trained by | Validated by

v v v
[ Naive Bayes Classifier ]

!

[ Predicted Fls J [ Annotated Fls ]<
| |

l

[ FlINetwork

Predicted by Extracted from

) 328K interactions
12K proteins
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127 Cancer Driver Genes

Signaling by
EGFR, FGFR, Signaling by
SCF-KIT, etc. ' Notch, Whnt,
TGF-beta,
S SMAD?2/3, etc.
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Module-Based Prognostic Biomarker in ER+ Breast
Cancer

1.0
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Measure levels of expression of
the genes in this network
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Visualize Cancer Targetome in the Reactome Fl
Network

Imatinib Mesylate - EGFR

Imatinib Mesylate
EGFR
1C50>100000 (BindingDB: NA_BindingDB_ChEMBL)
KD>1 (BindingDB: 18183025)

KD=76 (BindingDB: 18183025)

KD=7600 (BindingDB: 22037378)

KD>10000 (BindingDB: 18183025, 22037378)
KD=7600000 (BindingDB: NA_PubChem_aid1433)

Close

TCGA GBM Mutation Profile
B, RN X2
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3) Pathway-Based Modeling

° Apply list of altered {genes, proteins, RNAs} to biological
pathways.

* Preserve detailed biological relationships.

* Attempt to integrate multiple molecular alterations together
to yield lists of altered pathway activities.

* Pathway modeling shades into Systems Biology

W reactome EMBL-EBIT | Wiumoe ¥ $5cn



Types of Pathway-Based Modeling

* Partial differential equations/boolean models, e.g. CellNetAnalyzer
* Mostly suited for biochemical systems (metabolomics)

* Network flow models, e.g. NetPhorest, NetworKIN
* Mostly suited for kinase cascades (phosphorylation info)

* Transcriptional regulatory network-based reconstruction methods,
e.g. ARACNe (expression arrays)

* Probabilistic graph models (PGMs), e.e. PARADIGM

* Most general form of pathway modeling for cancer analysis at this time.

\Jn‘
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Probabilistic Graphical Model (PGM) based Pathway
Analysis

* Attempt to integrate multiple molecular alterations together to
yield lists of altered pathway activities.

* Many omics data types available for one single patient
* CNV, gene expression, methylation, somatic mutations, etc.
* Pathway and network-based Simulation

* Find significantly impacted pathways for diseases
* Link pathway activities to patient phenotypes

* Predict drug effects: one drug or multiple drugs together?

W reactome eveL-EBl || W 35




PARADIGM

MDM2 TP53
gene gene

‘W'/ * w4

— mRNA
w2 wb
e | *
MDM?2 TP53
l protein protein

*W3 wbé
: w/
Apoptosis MDM2 P53

Active Active
protein

Mutatlon

protein
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Probabilistic Graphical Models (PGMs) for
Reactome Pathways

e 2
e N

PPARARXRA
Coactivator complex

e
g’

S @ |
i

TWWTRl \ @—(TEAD:WWTRL(TAZ))

(TBXS5:WWTR1:PCAF)

l

& > ) |

(Runx2: wwR1TA2) )

nucleoplasm

J
J/
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PGM-based Single Patient Pathway View

[ NN ] Diagram of YAP1- and WWTR1 (TAZ)-stimulated gene expression Results Panel 0O x

Choose sample: = TCGA-09-0366 4>

Name = Value p-value FDR

TBL1IX_CNV 1 0.94 0.98
TBLIX_mRNA_... 1 1 1
TBL1XR1_CNV 1 0.96 0.98
TBLIXR1_mRN... 1 1 1
[TBXS mRNAEXP| o o0 023§
TEAD1_CNV 1 0.93 0.98
TEAD1I_mRNA_... 1 0.99 0.99
TEAD2_CNV 1 0.97 0.98
TEAD2_mRNA_... 1 1 1
TEAD3_CNV 1 0.98 0.98
TEAD3_mRNA_... 1 0.98 0.98
TEAD4_CNV 1 0.93 0.98
TEAD4_mRNA_... 1 0.99 0.99
TGS1_CNV 1 0.94 0.98
TGS1_mRNA_EXP 1 0.99 0.99
YAP1_CNV 1 0.96 0.98
YAP1_mRNA_EXP 1 1 1

Slide to Zoom: y Inference

Results Panel 0 x
Sample List

Choose sample: | TCGA-09-1668 >

Name = Value p-value FDR

TBL1IX_CNV 1 0.94 0.98
TBLIX_MRNA_... 1 1 1
TBLIXR1_CNV 2 0.04 0.64
TBLIXR1_mRN... 1 1 1
(TBXS mRNAEXP| o 0o 0.475]
TEAD1I_CNV 1 0.93 0.98
TEAD1_mRNA_... 1 0.99 0.99
TEAD2_CNV 1 0.97 0.98
TEAD2_mRNA_... 1 1 1
TEAD3_CNV 1 0.98 0.98
TEAD3_mRNA_... 1 0.98 0.98
TEAD4_CNV 1 0.93 0.98
TEAD4_mRNA_... 1 0.99 0.99
TGS1_CNV 1 0.94 0.98
TGS1_mRNA_EXP 1 0.99 0.99
YAP1_CNV 1 0.96 0.98
YAP1_mRNA_EXP 1 1 1

Slide to Zoom:

F— 2 RN X2
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MEDICAL CENTER OHU

atere

reqctome EMBL-EBI




Building Quantitative Models for Reactome

ODE Model - - ==

Future Direction

W reactome

Pathways

Reactome
Pathway

EMBL-EBI

Probabilistic
Graphical Model

Boolean Network
——

Model

~~
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Major Features in ReactomeF|Viz

. ST
Pathway analysis Pathway Pathway Pathway
features Activities Enrichments Activities
Perform Boolean Perform pathway Perform probabilistic graphical
network modeling enrichment analysis model (PGM) based pathway
J < modeling
Visualize
npu ancer Drugs ene_Lis e ene_Expression
| t C D Gene_List MAF CNV G E
Visualize
Cancer Gene Perform HotNet
analysis Perform network
Index Overlay Constrtt.lct FIkSUb' Or clustering with the
Overlay cancer networ |Functional Impact whole FI network
gene index ] Analysis via PGM
FI Sub-network
[ ———
Pathway or GO Perform network
Annotations Annotate with clustering
GO or
Overlay hit genes to pathways FI Network
athways
P Y Modules
| .—‘
Pathway Diagram Perform survival analysis using
Overlay CoxPH or Kaplan-Meier model
(R —
Survival Analysis
Network analysis Results
features
N b

reQctome EMBLEBI
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Al) Reactome Pathway Enrichment Analysis

XX
L -

Control Panel

Network  Style

-&’ag@‘@@

Session: New Session

3 as © @ Q

Diagram of Cell Cycle Checkpoints

Select Reactome

v <% Cell Cycle

> <% G1/S DNA Darf

» <% G2/M Checkp

» <3 Mitotic Spindl{
» <3 Cell Cycle, Mitotic
» <% Chromosome Mai
> & Meiosis
7%, Cell-Cell communicat]
%% Cellular responses to
<%, Chromatin organizatif

7. Developmental Biolog
<%, DNA Repair
<%, DNA Replication

A A Cell Cycle Checkp g

View Reactome Source
View in Reactome
Show Diagram

Search

Analyze Pathway Enrichment
Run Graphical Model Analysis
Load Graphical Model Results

Expand Pathway
Collapse Pathway

|
>
| 4
» <% Circadian Clock
>
| 4
>
>

» <% Gene Expression

<%, Extracellular matrix organization

i} .

Selected Event Branch
<%, Cell Cycle

v:f. Cell Cycle Checkpoints

:APC/C
complex

hBUBR1:hBUB3:
MAD2*:CDC20
complex

phosphorylated

—|anaphase promoting .
complex (APC/C) (

Kinetochore
Complex

Table Panel

Slide to Zoom:

# () wo oo 4 [ =0 flz)

Edge Table  Network Table

@® Memory

EMBL-EBI \rYUI.an gone %Y églCR

MEDICALCENTER g E e
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Displaying Reactome Pathways in the FI Network
View

Session: New Session

~B kh £f5F AQQAQA 2 Do o .
ox 0060

FI Nework for Diagram of Cell Cycle Checkpoints

Control Panel

e
Select N

Network  Style

Vv <% Cell Cycle
V¥ <% Cell Cycle Checkpoints
» <% G1/S DNA Damage Checkpoints
» <% G2/M Checkpoints
5
» <% Cell Cycle, Mitotic
> ':l: Chromosome Maintenance
> i Meiosis
<%, Cell-Cell communication
<%, Cellular responses to stress
vff.'. Chromatin organization
<%, Circadian Clock
%, Developmental Biology
<%, DNA Repair
<%, DNA Replication
» <% Extracellular matrix organization
Selected Event Branch

vVvyvyvVvyVvVvyywyy

%, Cell Cycle
V¥ <& Cell Cycle Checkpoints Convert to FI Network
Run Boolean Network Analysis £
ablejiaesl Remove Analysis Results B
phosphorylated
anaphase promoting & [0 oo 4 W =o f(z) Run Graphical Model Analysis
complex (APC/C) .

& o T s o Show Gene Level Analysis Results
hBUBR1:hBUB3: shared name name module commonName X "
MAD2*:CDC20 BABAML BABAML BABAML gasa  Show Observation 6

complex BRCA1 BRCA1 BRCA1 BRCA SaVe Analysis ReSuItS 36

PSMB1 PSMB1 PSMB1 PSME . 38

PSME2 PSME2 PSME2 pse  Open Analysis Results 8

HERC2 HERC2 HERC2 HER 36

HIST3H2BB HIST3H2BB HIST3H2BB HIST Fetch Cancer Drugs 36

PSME1L PSME1L PSMEL PSME . 38

HIST1H2BO HIST1H2BO HIST1H2BO HIST Filter Cancer Drugs 36

KDM4B KDM4B KDM4B KDM i6

Slide to Zoom: w Search Entities L
Edge Table N¢  Search Reactions
Export Diagram lory

W reactome EVBLEBI | WUunone 9 Foice



Pathway Enrichment Analysis

006
=B %k

Control Panel

Network  Style

FDR:

‘b IL7R binds JAK1

' IL2RG binds JAK3

B IL7 binds IL7RJAK1

B IL7:IL7RJAKL binds IL

B IL7R is phosphorylate|

b IL7:p-Y449-IL7RJAK]]

B IL7:p-Y449-IL7RJAK]]

' IL7:p-Y449-IL7R;JAK ]
= Interleukin-11 receptor al
 Interleukin-11 receptor al
B IL27 is a dimer of IL27A a|
T 1L27 binds IL27RA:gp130

AAEiA interleukin-7 signaling (FDR: 0.091)

B IL7 binds HGF(495-728) to form PPBSF

Session: New Session

[} a8 @& @

Q

Diagram of Interleukin-7 signaling and JAK3 deficiency causes SCID (IL7R)

ox (eee
Select
001  <0.001 |

View Reactome Source
View in Reactome
Show Diagram

Search
Analyze Pathway Enrichment

HGF(495-728)

. o@D

IL7R:JAK1 IL7:IL7R:JAK1

Run Graphical Model Analysis

8 0 O

Reactome Pathway Enrichment Analysis

Load Graphical Model Results

7

Expand Pathway AK3
Collapse Pathway

Selected Event Branch

Gene Set Loading

Choose a gene set file: hs_geneNames.txt
Specify file format: () One gene per line
O Comma delimited (e.g. TP53, EGFR)
() Tab delimited (e.g. TP53 EGFR)

b
Table Panel 0O %
| ok | | cancel |
: Apply Filters: FDR T.0 v]

ReactomePathway RatioOfProteininPat... NumberOfProteinin... ProteinfromGeneSet P-value FDR HitGenes
Laminin interactions  0.0032 23 5 0.0111 0.0890 ITGA6,LAMC1,LAMB...
Activation of Rac 0.0011 8 3 0.0114 0.0911 ROBO1,SOS1,SLIT2
Interleukin-7 signali... 0.0011 8 3 0.0114 0.0911 IL7R,HGF JAK1
CREB phosphorylati... 0.0021 15 4 0.0115 0.0917 GRIN2B,GRIN2A AKA...
Mismatch Repair 0.0021 15 4 0.0115 0.0917 RPA1,POLD3,MLHL,...
M Phase 0.0315 225 22 0.0117 0.0937 KNTC1,NDE1,UBC,A...

GABA receptor activ... 0.0074 53 8 0.0124 0.0993 GABBR2,GNAT3,GAB...
Mitotic Prometaphase 0.0139 99 12 0.0131 0.1016 KNTC1,NDE1,PDS5B,...
Digestion of dietary ... 0.0004 3 2 0.0132 0.1016 MGAM,LCT
Mitotic Anaphase 0.0227 162 17 0.0136 0.1016 KNTC1,NDEL,UBCA...
TGF-beta receptor s... 0.0022 16 4 0.0142 0.1016 UBC.PARD3.TGFBR2

Node Table  Edge Table  Network Table | izieionne Zaiaey/ 2aidle e
= @ Memory
|
/ > PN -\.*'9
reO N [ T ] EMBL-EBI NYULangone % :¥OICR
MEDICAL CENTER 50 @ T,




Visualize Cancer Targetome in Reactome Pathways

=R

Control Panel

e @AQQQ

Network  Style

v Ox
Select

+ Cell Cycle
G1/5 DNA Damage Checkpoints
¥ . G2/M Checkpoints
» 7 G2/M DNA damage checkpoint
» # G2/M DNA replication checkpoint
v % Activation of ATR in response to replication stress
P Stalling of DNA replication fork and RPA binding
= Binding of ATR-ATRIP to the RPA-ssDNA complex
P Recruitment of Rad17-RFC complex to DNA
F* Recruitment of the Rad9-Hus1-Rad1 complex to C
= Loading of claspin onto DNA during replication or
B Activation of claspin
P+ Recruitment and activation of Chk1
F» Phosphorylation of Cdc25A at Ser-123 by Chkl
= Phosphorylation of Cdc25C at Ser 216 by Chk1
F» GTSEL binds TPS3
J» GTSEL promotes translocation of TPS3 to the cytosol
}» GTSE1 facilitates proteasome-mediated degradation o
» % Mitotic Spindle Checkpoint
. Cell Cycle, Mitotic
<#. Chromosome Maintenance

5 Meiosis
+ Cell-Cell communication
+ Cellular responses to stress
+ Chromatin organization
+ Circadian Clock
* Developmental Biology
+ DNA Repair
* DNA Replication
+ Extracellular matrix organization
+ Gene Expression

Selected Event Branch
<1 Cell Cycle

REACell Cycle Checkpoints

R OB ®

SL00»< Q o

p-MRN:p-51981,Ac-K3016-A
>lyUb-K14,K16,p-5139-H2AFX
H4A-Nucleosome:p-ST-MDX
1:RNF8:2n2+:SUMO1:p-T
N:UBE2V2:RNF168:PIAS4:p-525,
BP1:p-45,2T-BRCAL-A complex

Diagram of Cell Cycle Checkpoints

DNA DNA DSBs:p-MRN:p-51981,Ac-K3016-ATM:KATS:
K63PolyUb-K14,K16,p-S139-H2AFX,Me2K21-HIST1H4,
o Nucleosome:p-ST-M ; :
1:p-T4827- HERCZ UBE2N: U

ss1 7 TPy

DC1:p-5102-WHSCL

(D) l
ATP
f £ (e )

ADP
@x .

E Convert to FI Network
S

Run Boolean Network Analysis
Remove Analysis Results

ATR:ATRIP:RPA:3

overhanging ssDNA-

DSBs:p-MRN:p-51981,

Ac-K3016-ATM:KATS

BRCA1-C complex

EXOL, DNA‘ BLM,WR
c

{e}
p-S387-Ri

Run Graphical Model Analysis
Show Gene Level Analysis Results \
Show Observation n=ES

Table Panel

reqctome

Save Analysis Results
Open Analysis Results

Fetch Cancer Drugs

Filter Cancer Drugs

Slide to Zoom:

v Ox

Load Mechismo Results
Remove Mechismo Results

Search Entities
Search Reactions
Export Diagram

Node Table  Edge Table

@ Memory

. -\.""9
W  S0Icr

L —
OHIU ~ G

EMBL-EBI
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A2) De Novo Subnetwork Construction & Clustering

c + ':,;:!:é" Machine Learning

Reactome Functional

> Interaction Network
(~12K proteins; ~328K
Curated Uncurated interactions)
Interaction
Pathway DBs ,
Evidence .
Project your data
i into Reactome FI
Cell cycle . It.:a:'\dspon
checkpoin®. « o0 o Network
;lr;::lji?\; Lo "" - ) (S‘Ii'?\tr;a»ll:‘dguced apoptosis) e ) ® }
Ay
GPCR sigﬂ’ﬁia‘:g e ..é;:ig"a""g 3
signaling 4,- QN & il . - . . Spiceosome
i g oo Extract and Cluster.
and Annotate Altere
Genes Cytoscape using ReactomeFIViz app
~ v
PN AT
NYULangone =
W reactome e - Joir




Upload your data

(3 Cytoscape File Edit View Select Layout [.\¢si58 Tools Help

Session: New Session

B e » @

®e® | App Manager...
= B L bt 285 & o
H : alh|
: 4 & 4 2 D . . GeneMANIA >
Control Panel WY  Reactome FI »
W Style  Select k

Network Nodes Edges

Gene Set/Mutation Analysis
PGM Impact Analysis >
HotNet Mutation Analysis
Gene Expression Analysis
Reactome Pathways

User Guide

FI plug-in supports four file formats:
- Simple gene set: one line per gene

« Gene/sample number pair. Contains two required columns, gene and
number of samples having gene mutated, and an optional third column listing
sample names (delimited by semi-colon ;)

*  NCI MAF (mutation annotation file)
« Sample Gene Expression data file

W reactome

xS
EMBL—EBI;;;;;g NYULangone % 20icr
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File Formats

* Choose Plugins, Reactome Fls.

* Fl plug-in supports four file formats:
* Gene list
* Gene-Sample gene

*  NCI Mutation Annotation File

* Microarray Expression Data

W reoctome EMBLEBI | (WWmne ¥ Foor
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Gene Set-based Analysis

Cytoscape File Edit View Select Layoutm Tools Help

| JON
)
‘ Q

3.1

Control Panel

L aQaQ

J App Manager...

CyBrowser >
Reactome FI

® @ 1

Session: New Sessic

Gene Set/Mutation Analysis

PGM Impact Analysis >
Gene Set/Mutation Analysis act RecentS¢  HotNet Mutation Analysis
~Reactome FI Network Version Gene Expression Analysis
© 2016 2015 | 2014 Q Reactome Pathways
* Different versions of the FI network may produce different results. ﬁ User Guide
~Gene Set Parameters ' ' .
Choose data file: Browse
Or enter gene set: [ 127 Genes Entered ]
Specify format: © Gene set
Gene/sample number pair
NCI MAF (Mutation Annotation File)
Choose sample cutoff: 2
* Genes altered in 2 or more samples will be chosen if '2" is entered.
Choose genes mutated at both alleles
~FI Network Construction Parameters b
| Fetch Fl annotations
* Annotations may be fetched later.
| Use linker genes
| Show genes not linked to others
WO Cnco
Al
reQctome EMBL-EBI \ YUl.an one % FOICR
usuut CENTER CTT '3 el




FI Results Display

Session: New Session

ER 4k £EF AQAAQ C Bmo©

Control Panel

Style  Select

Network s
222 LAC_genelist.txt
LAC_genelistoxe ____EELY)

Ox ©06e

LAC_genelist.txt

Delete
Edit

Select
Croup

Preferences »

Fetch Fl Annotations

Analyze Network Functions »
Cluster FI Network

Analyze Module Functions »
Load Cancer Gene Index

[SI(C] ™
Table Panel OX
& [ oo 4 W = f(z) The main features of
% shared name name i module i commonName i nodeToolTip i nodeLabel i nodeType & the plUg-ln are invoked
ACTB ACTB ACTB ACTB ACTB Gene from a popup menu
ITGAV ITGAV ITGAV ITGAV ITGAV Gene . . ?
RAD21 RAD21 RAD21 RAD21 RAD21 Gene which can be d|sp|ayed
YAP1 YAP1 YAP1 YAP1 YAP1 Gene . L .
JUN JUN JUN JUN JUN Gene by rlght C||Ck|ng a white
MAP2K7 MAP2K7 MAP2K7 MAP2K7 MAP2K7 G
Fos Fos Fos Fos Fos Gene space, a node or edge
UBC UBC UBC UBC UBC G i i
USF1 USF1 USF1 USF1 USF1 c::: in the the network view
panel.
Edge Table = Network Table

Constructed network is displayed in the Network View panel using

A~ G
\N!UI.angone Y FOIcR

| ]
MEDICALCENTER 5 @ T

EMBL-EBI

abese
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FI Annotations

Provides detailed information on selected Fls.

Three edge attributes are created:
* FI Annotation.

* FI Direction.

* FI Score (for predicted Fl).

Edges display direction attribute values.

« --> for activating/catalyzing.
* --| for inhibition.
» solid line for complexes or inputs.

+ ---for predicted Fls.

W reactome

The main features of the plug-in are
invoked from a popup menu, which can
be displayed by right clicking a node or
edge in the the netv;o.:&view panel.
EMBL-EBI i \NYULangone %9
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Edit
Select

Apps

Reactome Fl Query Fl Source

External Links
Preferences

I i

VV AAY VYV

Query Fl Source

Annotated Fls

Predicted Fls

[ NON ] Interaction Info

Interaction: SNX4 - SNX6

Support Evidence

Predictor Value
Human Interaction true
Yeast Interaction false
Fly Interaction false
Worm Interaction false
Mouse Interaction false
Pavlidis Gene Exp false
Carlos Gene Exp false
PfamDomain Interaction true
GO BP Sharing true
Score 0.9642255584531738

0 Interaction Info
Interaction: SIX5 - ZNF230 “
Reactome ID Type Data Source ‘
6951674 TARGETED_INTERAZ __cyeonnc
View Reactome Source
o0 Reactome Instance View
classType TargetedInteraction
ﬂ dbld 951674
|displayName |SIX5 ZNF230
f |dataSource |ENCODE
definition (E}l(‘l)CBOPD.E'pfoximal_fillered TF/target interaction; supported by
[ L™ sharing
factor SIXS
[species ‘Homo sapiens

Close

W reactome

EMBL-EBI :

\.'*09
" Ol OICR
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Cluster FI Network

Runs spectral partition based network clustering (Newman, 2006) on the
displayed FI network.

Nodes in different network modules will be shown in different colours (max
15 colours).

Analyze cancer mutation data with HotNet algorithm (Vandin, 2012)

Add > N N
Delete > "X‘SE‘\W@X;'..
Edit > NS0,
Select > £ B
Group > ~

Apps »

Fetch Fl Annotations
k‘ Analyze Network Functions »
Cluster FI Network
Analyze Module Functions »
Load Cancer Gene Index

Preferences »

EMBL-EBI " \NYULangone %9 F0
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Analyze Module Functions

* Pathway or GO term enrichment analysis on individual network modules.

1 Add >
« Use filter to remove small network modules pelete >
Edit >
. File >
- Filter by FDR Gow >
Apps > |
Fetch FI Annotations
Analyze Network Functions »
Layout < Cluster FI Network I
Select > Analyze Module Functions » Pathway Enrichment
Load Cancer Gene Index CO Cell Component
| GO Biological Process
GO Molecular Function
- Survival Analysis
Data Panel
(] Hide nodes in not selected rows ;Apply Filters: FDR | 0.01 = ] Module Size [ 10 : ¥
Module GeneSet RatioOfProteinin 0.0010 mModule F-! 15 | Nodes
0 Translation(R) 0.0158 0.0050 0, 13 | RPL18,RPL17,RPL36... 6
0 Influenza Life Cycle(R) 0.0249 0 12 RPL18,RPL17,RPL36...
0 Ribosome(K) 0.0117 0.05 o 11 RPL18,RPL17,RPL36...
0 Metabolism of protei... 0.0267 0.25 0 st | ———— RPL18,RPL17,RPL36...
1 M Phase(R) 0.0128 0'5 o0 9 ITGB3BP,MAD1L1,CC...
1 Aurora B signaling(N) 0.0052 : 0, 8 al AURKC,AURKB,CDCA...
1 Signaling by Aurora k... 0.0125 1.0 o - + | AURKC,AURKB,CDCA...
2 Glucose Regulation of... 0.0197 148 16 ~UUUU <I.07E€=U% NDUFB4,NDUFA2,ND...
2 Parkinson's disease(K) 0.0176 132 15 0.0000 <1.67e-04 NDUFB4,NDUFA2,ND...
2 Alzheimer's disease(K) 0.0223 168 15 0.0000 <1.67e-04 NDUFB4,NDUFA2,ND...
2 Huntington's disease(K) 0.0246 185 15 0.0000 <1.67e-04 NDUFB4,NDUFA2,ND...
2 Oxidative phosphoryl... 0.0178 134 15 0.0000 <1.67e-04 NDUFB4,NDUFA2,ND...
2 Electron Transport C... 0.0101 76 16 0.0000 <1.67e-04 NDUFB4,NDUFA2,ND...
2 Metabolic pathways(K) 0.1489 1120 16 0.0000 <1.43e-04 NDUFB4,NDUFA2,ND...
3 Antigen processing a... 0.0104 78 9 0.0000 <1.00e-03 KLRC2,KIR2DS1,HLA...
3 Immunoregulatory int... 0.0153 115 8 0.0000 <5.00e-04 KIR2DS1,HLA-B,HLA... |a
3 Natural killer cell me... 0.0182 137 7 0.0000 <3.33e-04 KLRC2,KIR2DS1,HLA... |v
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Other Features — Show Pathway Diagrams

* Select a pathway in "Pathways in Network/Modules" tabs,

select "Show Pathway Diagram’

Data Panel

[_] Hide nodes in not selected rows EAppIy Filters:

Module GeneSet

0 Arf6 signaling events(N)
0 Insulin Pathway(N)

right click,

800

Pathway Diagram View

Diagram View: Signalling by NGF

cytosol

endoplasmic reticulum lumen

—F—» prNG?a— — 7@ > " NGF Overview
0 homodimer

0 IGF1 pat Export Annotations
0 Endothe| .
0 Prostate  Show Pathway Detail
0 ik Show Pathway Diagram
I NEUROACTIVE LIGAND-RECEPTOR INTERACTION 0 Plasma membrane estrogen receptor signaling(N)
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Other Features — NCI Cancer Gene Index

* View detailed annotations for the selected gene or protein.

* Annotations are sortable by PubMed ID, Cancer type, status, and other

criteria.

(1o Cancer Index Annotations

Cancer Gene Index Annotations for "MAF"

Order by [ PubMedID )-5-] ( Set Filters ) Current filters: None

Results: 1to 8 of 8 €€ First | | € Prev|Page 1| & Next || Last

Add

Edit

Select

Group

Nested Networks

Apps

Reactome FI

External Links
Preferences

\AY VVVYYVYY

vy

Fetch Fls

Fetch Cancer Gene Index
Query Gene Card

Query Cosmic

Analyze Nodes Functions »

/
/

Cancer type: tumors Tr
Primary NCI role code: Gene_Has_Anormally

Other roles: not_assigned

Evidence code: EV-AS-TAS

Negation indicator: no

Cellline indicator: no

Status: finished

PubMedID: 16155016

Comment: Anomalie_Detail: Chromosomal_Translocation

Nearly half of tumors are nonhyperdiploid, and mostly have one of five recurrent IgH translocations: 16% 11ql3
(CCN D1), 3% 6p21 (CCN D3). 5% 16q23 (MAF), 2% 20q12 (MAFB), and 15% 4p16 (FGFR3 and MMSET).

reqctome

Cancer type: tumors

Primary NCI role code: Gene_is_Biomarker_of
Other roles: not_assigned

Evidence code: EV-EXP-IEP, EV-EXP-IDA
Negation indicator: no

Cellline indicator: no

Status: finished

PubMedID: 15755896

Using gene expression profiling to identify 5 recurrent translocations, specific trisomies, and expression of cyclin D
genes, MM tumors can be divided into 8 TC (translocation/cyclin D) groups (11q13, 6p21, 4pl6, maf, DI, D1+D2,
D2, and none) that appear to be defined by early. and perhaps initiating, oncogenic events.

Cancer type: plasma-cell leukemias (pcl)
Negation indicator: no

Cellline indicator: no

Status: no_fact

PubMedID: 15543617

A

We investigated the expression profiles of the FGFR3/MMSET, CCND1, CCND3, MAF, and MAFB genes, which '7
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Other Features — Overlay Cancer Gene Index
* Load the NCI disease terms hierarchy in the left panel.

* Select a disease term in the tree to select all nodes that have this annotation
or one of its sub-terms.

Session: New Session "
» » . H e — N )
L@ , « By Wb B ‘ ‘
=B e e WE A’ R %8 3 B | @
Control Panel & X
¥/ RS 7 N SV
| < VizMapper Filters NCI Diseases 1 VAR ) IA ;’ d Q\‘:‘A
% ¥,
— / M i RS
Disease Hierarchy 7 / A k‘;“i
v # Diseases_and_Disorders
» # Behavior-Related_Disorder
» # Cancer-Related_Condition
» # Disorder_by_Site >
» # Cenetic_Disorder Edit >
» # Hamartoma Select >
> # Hyperplasia
Group >
v # Neoplasm
» # Neoplasm_by_Morphology Nested Networks »
v # Neoplasm_by_Site
v # Breast_Neoplasm AppS >
» # Benign_Breast_Neoplasm Reactome Fl > Fetch Fls
» & Breast_Fibroepithelial_Neoplasm External Link o Fetch Cancer Gene Index
# Breast_Granular_Cell_Tumor p ? al Links ( Query Gene Card
5 rererences f
» # Breast_Hyperplasia I - Query Cosmic
» # Breast_Myoepithelial_Neoplasm 4 i
- - Analyze Nodes Functions »
» # Breast_Neuroendocrine_Neoplasm Ve
# Breast_Nevus /
» # Breast_Soft_Tissue_Neoplasm u
» # Columnar_Cell_Lesion_of_the_Breast
» # Intraductal_Breast_Neoplasm
» # Lobular_Neoplasia
» # Malignant_Breast_Neoplasm
» # Nipple_Neoplasm Table Panel SX
LR MPapillary_Breast_Neoplasm
» # Cardiovascular_Neoplasm [ Hide nodes in not selected rows : Apply Filters: FDR| 0.25 + | Module Size| 1 &l El
> Conne;(ive_and_Soﬁ_Tissue_NeopIasm Module GeneSet RatioOfProteinin... | NumberOfProtei... ProteinfromMod... |P-value FDR Nodes
—» # Fodacrine Neanlasm 0 Bladder cancer(K) 0.0038 38 2 0.0063 2.026e-01 E2F3,CDKN2A
Definition 0 Lysosome(K) 0.0123 122 3 0.0065 1.906e-01 ARSG,NEU1,SCA...
Papillary_Breast_Neoplasm (C5206): not defined 0 HTLV-I infection... 0.0262 260 4 0.0084 2.256e-01 E2F3,CDKN2A, ...
0 Validated trans... 0.0049 49 2 0.0103 2.498e-01 PMAIP1,CDKN2A
1 Focal adhesion(K) 0.0208 206 8 0.0000 <1.000e-03 TLN2,TNCBCA...
1 Integrins in angi... 0.0047 47 4 0.0000 4.000e-03 BCAR1,PTK2B,I...
1 Type Il diabetes... 0.0048 48 4 0.0000 2.667e-03 KCNJ11,PRKCE,...
1 Signaling by EG... 0.0172 171 6 0.0000 3.000e-03 FGF9,LRIG1,SPR...
1 Endothelins(N) 0.0063 62 4 0.0001 4.400e-03 BCAR1.PTK2B.P...
| Node Table = Edge Table = Network Table = Network Module Browser [Hz=iaaliElE RN S
y ‘ Memory: 0K @
. S Y
< { .
-
reQctom e EMBL-EBI NYULangone ¥ :¥OICR
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Other Features — COSMIC

* View detailed variant annotations for the selected gene or protein from
COSMIC database.

quue of somatic mutations in cancer
Cosmic » Gene » Analysis » TP53 Filters
Genome Browser Overview Tissue Distribution Variants References Gene TP53
0 Position
QP r IO} ° Start 1
e [ ek T R T T R T TE T maciew End 304
w169
’ Sequence Type:
I’ cDNA
/ Amino Acid o
Cancer type Select
Add > Substiuton & Systematic Screen
Edit > & Somatic Status
Select | A @ Tumour Source
@ Mutation Impact @
Group > © Mutation Type
Nested Networks » © Copy Number Variation
@ Gene Expression
Apps > Amino acid @ Methylation
Pfam P53 iotramed I
Reactome FI » Fetch Fls . " Wl ot Tl [ Reset J
E I Link Fetch Cancer Gene Index o T' ' ! I’
thsrna inks : Query Gene Card A
|__rejerences . Query Cosmic e
! .
/ Analyze Nodes Functions » o { ool gy
1 - Deletions.
Y 7 8
CNV Gain
o
o] | —
Over Expression
Under Exuvs:eﬂ
i
Hyper Methylation
Hypo Methylation
O e e b b e et s
fy o in o i o Fa
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Module Based Survival Analysis

* Discover Prognostic Signatures in Disease Module Datasets.

* Based on a server-side R script that runs either CoxPH or Kaplan-Meyer
survival analysis.

* Requires appropriate clinical data file.

o _| = gmupz
Results Panel Tal -
Survival Analysis
Analysis: Coxph (all modules) 3
~===0utput=-=-=--
Add > Note: Click underlined modules in blue
Delete > for single module-based analysis. You S
Edit > may not see any underlined module If all §
File > p-values > 0.05. 8
Group > '§
Apps N Module Coefficient P-value o g |
Fetch FI Annotations 0 =0.6142421 0.0015 °
Analyze Network Functions » 1 1.308675 2.7e-10
Layout > Cluster FI Network 2 0.4908374 0.015
Select > Analyze Module Functions » Pathway Enrichment 3 0.3854999 0.071 ~
Load Cancer Gene Index GO Cell Component 4 0.1916897 0.38 S
| GO Biological Process 5 1.015691 4.4e-07
GO Molecular Function 6 -0.06630745 0.71
Survival Analysis 7 -0.01376751 0.94
8 0.4978022 0.053 2
2 0.948809 3.8e-06 | | |
A0 0.6773846 0.024
11 0.09736692 0.61 0 3 10 1
12 ~0.6155788 0.00033 Time
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For any questions or feedback, please contact
help@reactome.org
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